TopLeaf Release Notes

2012/01/03

IMPORTANT NOTE: Turn-Key Systems is committed to the quality and
completeness of the TopLeaf documentation. If you notice an error or omission, or
wish to have some point more fully covered, please contact us at
support@turnkey.com.au. Let us know the location and nature of the problem
and we will do our best to address the issue in the next release.

1. 7.6.022

TopLeaf 7.6 uses a different installer technology. If you are currently using TopLeaf 7.5 or earlier
you must uninstall that distribution before installing TopLeaf 7.6.

In keeping with the current Windows practice, the default TopLeaf repository location has moved
from C:\TopLeaf to (My) Documents\TopLeaf. You can of course still change this location at any
time via the File » Preferences dialog.

1.1 Date released
2012/01/03

1.2 Enhancements

1.2.1 Selection of trim or bleed box for imported PDF images

(bug 1953) The <i mage- pr oper ti es/ > command now allows you to select the PDF trim box
and bleed box when sizing a PDF image.

1.2.2 Determining the number of times a telltale is declared

(bug 1984) Data telltales are used to track location specific information in a document that is then
set outside of the data columns to which it applies. The <set ... /> command can be used within
a header or footer block to retrieve the number of times a specific data telltale has been assigned
within the current page.

1.2.3 Optional image conversion for grayscale color space

(bug 1991) Selecting the grayscale color space in a PDF profile automatically converts images to
grayscale. For vector images this involves a conversion to a bitmap. If the images are already
grayscale the conversion is not required.

1.3 Bug Fixes
The following bug fixes were applied in this build.

1.3.1 Post-process did not produce diagnostics on error

(bug 1327) TopLeaf now reports a warning if the post-process command cannot be started or
returns failure.
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1.3.2 Misleading error if publication level assigned as repository

(bug 1899) When the repository path was set to point to a publication folder instead of the
repository root, the open dialog showed the partition and allowed it to be opened. An attempt to
typeset the partition generated a fatal error.

1.3.3 Spaces lost in running foot

(bug 1982) Space was lost within any content emitted by the following Note Manager styles:
. $col not e- separ at or
. $pagenot e- separ at or
. $runhead- separ at or
. $col runf oot
. $pager unf oot

because the styles were declared internally as empty-tag elements.

1.3.4 Layout compiler did not set link line flag

(bug 1983) When a link line fixed block was inherited from another page style, the content of the
fixed block was not recognised as a link line.

1.3.5 TopLeaf GUI cannot start document editor

(bug 1985) The TopLeaf GUI failed to launch the preferred document editor if the editor program
was assigned with read-only file permission.

1.3.6 PDFimage scaling is incorrect

(bug 1986) The <i mage- pr operti es/ > command allows you to select a preferred PDF
bounding box when rendering a PDF image. The typesetting engine applied an incorrect PDF
bounding box if the same image was referenced using different preferred PDF bounding boxes.

1.3.7 PDF font embedding not honoured when processing legacy style sheets

(bug 1990) TopLeaf calls a legacy PDF builder to process output from style sheets created for
TopLeaf 6.1. A request to embed a font in the PDF was ignored.
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2. 7.6.021

2.1 Date released
2011/12/15

2.2 Enhancements
None.

2.3 Bug Fixes
The following bug fixes were applied in this build.

2.3.1 Javapost-processing

(bug 1328) TopLeaf can invoke a post-processing program (.EXE or .BAT) after a typesetting
run has finished. If the command is either java or javaw (case-sensitive) the java runtime specified
in the preferences dialog will be used.

2.3.2 Block elementin alink causes HTML conversion to fail

(bug 1935) When running a secondary output transformation, a block element in a link caused
the HTML conversion to fail.

2.3.3 Sidenote positioning
(bug 1938, 1939) Some errors associated with the positioning of sidenotes have been corrected.

2.3.4 Better scheme typeface selection for transforms

(bug 1942) If atypeface selection scheme is referenced in a mapping the converter will use it to
determine the typeface to use. For HTML secondary transforms, all of the typeface names are used
in the CSS style. For RTF transform, only the one typeface name is used.

2.3.5 Temporary file creation fails on Windows 7

(bug 1944) A secondary output transformation failed when called from a TopLeaf server
installation running under Windows 7.

2.3.6 Crop marks too close together

(bug 1946) Several people have commented that the default gap between the crop marks and the
crop box boundary is too small. The gap set when "Draw crop marks" is first checked has been
increased. This will not affect any publications that already have this selected.

2.3.7 Incorrect rendering of boxed content in secondary transform

(bug 1947) When running a secondary output transformation, a box containing multiple blocks
was incorrectly terminated after the first block.

2.3.8 Do not set retain space on $document within XML stylesheet
(bug 1948) The XML style sheet no longer sets retain space within the $document mapping.
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2.3.9 Unicode formatting characters were processed as glyphs

(bug 1950) The Unicode formatting characters U+2028 (line separator) and U+2029 (paragraph
separator) are now ignored.

2.3.10 Drop down list of commands is empty

(bug 1957) A style sheet upgrade was applied. When editing a tag customisation, the drop down
list of commands was empty.

2.3.11 Incorrect folio generated for 999(ab) format

(bug 1958) The verso page number generated for a looseleaf 999(ab) page folio was incorrect.
For example, if a stroke page was created for page 4(a) and page 4(b), the value of the verso page
folio string was 4(c).

2.3.12 Improvements to page previewer

(bug 1959) In the page previewer Go to page dialog, selecting a page label from the list now sets
the page number field.

2.3.13 Layout compiler produced incorrect result for mirrored data area

(bug 1960) If the data area had mirrored margins the data blocks created by the layout compiler
were positioned incorrectly.

2.3.14 Abnormal exit when typesetting in column footnote split mode

(bug 1961) The typesetting engine generated an abnormal exit if split column footnotes were
enabled.

2.3.15 Tableindentis incorrect when table cell widths exceed available measure

(bug 1963) A table was defined with columns that were too wide to fit the available measure. The
table column widths were resized without generating a warning.

2.3.16 Minimum distance after label

(bug 1965) It is now possible to define the minimum gap between a label and the adjacent
paragraph text. If the label is wide enough to reach the text column, the paragraph content will be
indented to leave at least this much gap after the label.

2.3.17 Incorrect end of leaf mode if leaf ends on a vertical space

(bug 1967) When processing a looseleaf mainwork, a leaf break occurred immediately after a
forced end of paragraph. The end of leaf paragraph justification was tracked as a paragraph
overflow. In a subsequent update, the composition engine rendered the last line of th paragraph as
a fully justified line.

2.3.18 Element content not recognised when processing table content

(bug 1968) The content model controls how to process the content of the element being mapped.
The Element content model was ignored when mapping the content of a tag declared within a table
cell.

2.3.19 Incorrect measurements written to style sheet layout

(bug 1969) The number format used to write measurements in a style sheet layout is now locale-
independent.
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2.3.20 Tableindentis incorrect when table is declared within a breakable box

(bug 1971) The calculated table indent was incorrect when rendering a table declared within a
breakable box.

2.3.21 Exception dictionary entries are case-insensitive

(bug 1972) Entries loaded into a hyphenation exception dictionary list were treated as case
sensitive strings, but the documentation stated that the entries are read as case insensitive strings.

2.3.22 Float positioned outside data area

(bug 1974) A column float was declared the beginning of the last paragraph in a column. The depth
of the float was not taken into account when distributing excess vertical space between lines on the

page.

2.3.23 Abnormal exit when processing margin rule

(bug 1975) The typesetting engine generated an abnormal exit when processing a margin rule
that spanned two or more pages.

2.3.24 Problem with link region when font returns zero ascent

(bug 1976) The PDF builder calculated the rectangle for a hyperlink using the ascent and descent
metrics of the font used to render the text. An example was found where the values returned for a
particular font were zero, which produced a link region with the minimum height, making it very
difficult to select.

2.3.25 Float box and image style not saved to XML stylesheets
(bug 1977) Float box and image styles are now saved to TopLeaf 7.6 XML style sheets.

2.3.26 Running head separator below paragraph space not applied

(bug 1978) The $r unhead- separ at or defines an optional separator placed immediately below
the lowest running head rendered on a page. The paragraph below space for this mapping was
not applied.

2.3.27 Incorrect directionality assigned to neutral characters

(bug 1980) A character with neutral directionality was followed by a character with weak
directionality. Both characters were located between characters with strong directionality. The
typesetting engine's bidirectional processor assigned an incorrect weak directionality to the
neutral character.

2.3.28 Incorrect indents applied if line consists entirely of neutral characters

(bug 1981) The typesetting engine processed a paragraph declaring RTL directionality. An
incorrect left and right indent was applied if a rendered line consisted entirely of neutral characters.
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3. 7.6.017

3.1 Date released
2011/10/27

3.2 Enhancements
None.

3.3 Bug Fixes
The following bug fixes were applied in this build.

3.3.1 Fixed block alignment is incorrect when processing RTL book

(bug 1854) When processing a double sided page layout, the composition engine applied an
incorrect page layout when processing left and right pages for documents that specified RTL
document directionality.

3.3.2 Incorrect rendering of neutral characters when processing RTL content

(bug 1869) The composition engine assigned an incorrect direction to characters that have neutral
or weak directionality when processing content that specified an RTL character directionality.

3.3.3 No error reported when failing to create a partition update

(bug 1888) When creating a partition update, TopLeaf failed to create a copy of an image
referenced from a published page file.

3.3.4 Unterminated underline caused PDF builder to fail

(bug 1927) The typesetting engine did not include an end of underline request in a rendered page.
The PDF builder was unable to create an output PDF.

3.3.5 TopLeaf publication level not recognised if folder is marked as read-only

(bug 1929) The folder permissions for a TopLeaf publication level were set to read-only. The
publication level was not recognised when traversing the repository using the File » Open dialog.

3.3.6 Could not process EPS files that contain large preview sections

(bug 1930) The PDF builder reported an error when processing EPS files that contained large
bitmap previews sections.

3.3.7 Stylesheet compiler did not set correct hyphenation mode

(bug 1937) When the stylesheet compiler was executed outside of the GUI it did not set the
hyphenation mode declared in the Format » Options, with the effect that all hyphenation was
disabled.
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4. 7.6.015

4.1 Date released
2011/10/06

4.2 Enhancements

4.2.1 Output differencing area

(bug 1060) In a page layout, the difference area defines the part of the page used to determine if a
page has changed. A new option has been added which allows the difference area to be calculated
from the smallest rectangle that covers all of the data blocks.

4.2.2 Locale support

(bug 1664) TopLeaf now tracks the locale as well as the language (eg. pt - BRfor Brazilian
Portuguese). The locale can be accessed via a TopLeaf variable, and used in font selection (eg.
simplified vs traditional Chinese).

4.2.3 Enhanced sidenotes

(bug 1666) A sidenote is a block of text and/or graphics rendered adjacent to a line of text called
the sidenote reference line. The depth of the sidenote and the reference line is now taken into
account when positioning sidenotes, making it possible to define multiple sidenotes from a single
reference line, and sidenotes of arbitrary depth.

4.2.4 Allow multi-pass composition runs to be disabled when called from GUI

(bug 1705) Multi-pass composition can be suppressed when running from the GUI via the
File»Preferences menu.

4.2.5 XML stylesheets

(bug 1735) A stylesheet defines the typesetting styling rules used by the TopLeaf composition
engine when a document is rendered. Each stylesheet consists of a set of mapping rules and a
page layout definition. In previous versions, TopLeaf stored the mapping rules in several files. They
are now stored in a single XML document.

Warning:

Note that all newly created stylesheets are stored as XML documents. Stylesheets created
using previous builds of TopLeaf are still supported and can be optionally upgraded to
the new XML format. Note that at some point support for the older stylesheet format will
be withdrawn and those stylesheets will be automatically upgraded.

4.2.6 Hyphenation exception dictionaries

(bug 1736) If you want to control the way TopLeaf hyphenates a word, you can add that word to a
hyphenation exception dictionary A hyphenation exception dictionary can be used to declare

your own hyphenation break points, or to stop TopLeaf from hyphenating a word altogether.

4.2.7 Improved control of page footnote margins

(bug 1742) By default, the margins for the page footnote region are determined by the page type in
force at the top of the page. The left margin is set to the left-most edge of any data, sidenote or
margin rule block in the page type. Similarly, the right margin is the right-most edge of any of these
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blocks. You can use the <note-properties/> directive to force TopLeaf to calculate the left and right
margins for the page footnote region from a specific page type.

4.2.8 Add parameter to allow when rows can split
(bug 1743) Add spl i t - rowkeephei ght attribute tot abl e- properti es command.

4.2.9 Page boundary markers

(bug 1879) A boundary marker is a TopLeaf processing instruction that identifies a published leaf,
page, or line boundary within a looseleaf document. TopLeaf can now track the position of the recto
page break points within the published leaf set. You would use this option when you need to export
an XML document that contains all leaf and page boundaries.

4.3 Bug Fixes
The following bug fixes were applied in this build.

4.3.1 Measures for U+NNNN spaces return identical widths
(bug 1808) Return appropriate values for widths of various Unicode space characters.

4.3.2 False change indications on graphics
(bug 1815) Graphics with spaces in their filename are now copied correctly when publishing.

4.3.3 Saved pages for published partition can have wrong font information

(bug 1816) Font information stored in older versions of documents must not be affected by
subsequent changes to font configuration.

4.3.4 Stylesheet reportissues

(bug 1817) The feature which produced a PDF of the current stylesheet has been disabled.

4.3.5 Abort on binding empty page segments
(bug 1826) Attempting to bind empty page segments together aborted the typesetting run.

4.3.6 Incorrect error about number of columns in table
(bug 1828) A correctly defined table was raising an error.

4.3.7 Non-breaking space is hyphenating
(bug 1836) In certain cases, TopLeaf allowed a non-breaking space to break and hyphenate.

4.3.8 Float image does not use whole page

(bug 1838) A floating graphic should use the column height of the page where it is printed, not the
page where it is called.

4.3.9 No error for incorrect vertical spans

(bug 1842) Incorrect vertical spanning in HTML tables was not raising an error.

4.3.10 RTL language processing

(bug 1853) Right to Left processing is now activated automatically if implied by the document
language.

Page 8



7.6.015

4.3.11 PDF builder could hang when an EPS error occurred

(bug 1855) When GhostScript reported an error the PDF builder could hang trying to read the error
message.

4.3.12 Content positioned incorrectly when box style applied to fixed block

(bug 1857) Content more than a few lines deep was being rendered incorrectly in a boxed fixed
block.

4.3.13 64 bit GhostScript support
(bug 1862) Improved GhostScript detection (search order, x64 support).

4.3.14 Implied rule height
(bug 1877) The implied rule height for a <rule/> directive is now 5dp

4.3.15 Hyphen not rendered when processing a leaf

(bug 1878) When typesetting a looseleaf document, a leaf boundary ended within a hyphenated
word. When the leaf was processed in a subsequent update, the hyphen was not rendered.

4.3.16 Secondary transformations failed if table defined a table header style without a fill
color

(bug 1891) Secondary transformations failed if CALS or HTML table defined a table header style
without a fill color.

4.3.17 GUIl hangs when opening a partition

(bug 1893) The TopLeaf GUI hung when attempting to access a previously typeset page that
contained no content.

4.3.18 Font selected by charmap is incorrect

(bug 1897) The typesetting engine selected the wrong font when applying a character mapping
rule.

4.3.19 Position of page folio is incorrect when using schemes

(bug 1917) The measure for the text emitted by the page <folio/> directive was calculated
incorrectly if the current typeface was derived from a typeface scheme.
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5. 7.5.031

The following chapter outlines the major changes in releases 7.5.024 — 7.5.031 of TopLeaf.

5.1 Date released
2011/09/02

5.2 Enhancements

5.2.1 Add support for larger paper sizes
(bug 1754) Itis now possible to render content to pages that declare a paper size larger than AO.

5.3 Bug Fixes
The following bug fixes were applied in this build.

5.3.1 Wrong page type selected

(bug 1745) A forced page and change of page type was requested. The selected page type was
applied before all of the content preceding the forced page end had been rendered.

5.3.2 Incorrect processing of attribute names and attribute references

(bug 1748) A number of issues relating to the declaration of attribute names or references to
attribute variables within Map Manager tab fields have been corrected.

5.3.3 Table row does not split

(bug 1749) A table row consisted of a series of single line paragraphs, each of which declared a
link target id. The depth of the table row exceeded the column depth. Table row splitting was
enabled, but TopLeaf failed to split the table row.

5.3.4 Default style sheet declares incorrect font for note styles

(bug 1750) When a new style sheet was created the font tab for $colnote-reference and
$pagenote-reference had both "small" and "superscript" selected.

5.3.5 Non-standard description of soft hyphens

(bug 1753) The mapping guide incorrectly referred to soft hyphens as &shy; . XML does not define
this entity.

5.3.6 Telltale not set correctly

(bug 1755) If table row splitting was enabled, the value assigned to a data telltale was not tracked
correctly.

5.3.7 Nested box failure

(bug 1756) The typesetting engine now generates a non-fatal error if the calculated vertical offset
for the start of a breakable box and an unbreakable box is identical.

5.3.8 Only use first bounding box found in EPS

(bug 1758) An EPS file contained two %%BoundingBox lines. The PDF builder scans the whole
EPS for bounding box definitions, since it gives preference to the HiResBoundingBox. The code
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has been changed to ignore any BoundingBox after the first. There will still be a problem if there is
a HiResBoundingBox that disagrees with the BoundingBox.
5.3.9 Add controls for multiple PDF output files

(bug 1759) The PDF builder looks for metadata variables of the form:pdf.output.N and creates a
PDF file for each one. The value of the variable is an optional page list followed by a file name.

5.3.10 Incorrect processing of cell shading and cell vertical rules in split table rows

(bug 1760) When table row splitting is enabled, TopLeaf is permitted to insert a break point within
the content of a table row that continues across a column or page boundary. In some
circumstances, the shading and rules were positioned incorrectly when a shaded row was split.
Where a break point occurs within a split table row, the split-offset specifies the distance between
the break point and the baseline of the content located immediately above it.

5.3.11 Remove restrictions on paragraph alignment

(bug 1762) It is now possible to set inside or outside paragraph alignment for the running head
separator and running foot note styles.

5.3.12 Float causes text to be positioned incorrectly

(bug 1764) The text following the insertion point of a full column float object was positioned
incorrectly when allocated to a multi-column page type.

5.3.13 PDF builder needs to know when only changed pages are selected

(bug 1765) The PDF builder now knows when it is creating a PDF from changed pages only, or
from a user-created map, so it can disable the creation of additional files.

5.3.14 Text positioned incorrectly for HTML tables with empty cells

(bug 1766) When an HTML table contained cells with no content, the non-breaking space inserted
to make the cell non-empty was incorrectly positioned.

5.3.15 Error now flagged if no page output generated

(bug 1768) The composition engine now returns a fatal error if no output is generated when a
partition is typeset.

5.3.16 Error when input differencing UTF-16 content

(bug 1771) A document specifying a UTF-16 character encoding was applied as an update for a
markerless looseleaf partition. TopLeaf failed to identify the set of changed input leaves.

5.3.17 Table headings not terminating

(bug 1772) In some circumstances, an automatic table header was generated even when a table
has terminated prior to the page end.

5.3.18 Cannot create a new update for a change pages looseleaf partition

(bug 1773) A change pages looseleaf document was published, and a new update created. If the
partition was published in a second update cycle, TopLeaf failed to create a new update release.

5.3.19 Output page differencing applied on each pass of a multi-pass composition run

(bug 1774) The <r eadgen/ > directive triggers an automatic multi-pass composition run. In
changed pages or regular looseleaf, an output page check is now only applied on the final pass of a
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multi-pass composition instance or when reading the contents of a generated set of filing
instructions.

5.3.20 Custom content lost for tag mapping in custom marker context

(bug 1775) A mapping declared one or more custom markers in the tag-in-context path. The
custom content for the mapping was lost when saved and opened again.

5.3.21 GUI hangs when opening a corrupted partition

(bug 1776) In a TopLeaf partition, the content of each release is held in a release folder. The
TopLeaf GUI hung when attempting to open a partition that referenced an undefined release folder.
5.3.22 Page type names did not allow spaces

(bug 1779) It is now possible to create a new page type using a name containing a space.

5.3.23 CSS importer fails if content string is empty

(bug 1780) Arule suchast ag: before{ content: ""; } caused the TopLeaf style sheet CSS
importer to fail.

5.3.24 Failure when creating level names containing spaces

(bug 1783) The TopLeaf GUI failed when attempting to create a level with a name containing a
space.

5.3.25 Crop mark style for individual pagetypes not preserved

(bug 1784) The information for drawing crop marks specific to a single pagetype was not read
correctly from the layout. All pagetypes with their own crop mark style should be reviewed and
corrected if necessary. This does not affect the "global” crop mark style applying to all other

pagetypes.

5.3.26 Preference control not honored

(bug 1786) The value of the Show the Format file folder name when viewing mappings user
preference was not honored.

5.3.27 Margin rule end adds extra page

(bug 1789) A graphic image filled an entire page. When the image was followed by an end margin
rule request, the typesetting engine generated an additional empty page.

5.3.28 Typesetting engine does not recognise xml encoding

(bug 1791) The text engine failed to recognise the xml encoding in the following declaration:
<?xm version="1.1" encodi ng="i so-8859-1""?7>

5.3.29 Font characteristics not tracked when processing combining characters

(bug 1792) When processing content that included a reference to a Unicode combining character,
the typesetting engine failed to track the font characteristics state.

5.3.30 Custom colors not displayed in color pick dialog

(bug 1793) When the color picker dialog opens, if the initial color is not in the list of custom colors
declared by the stylesheet, and it is not one of the 48 standard colors, it is added to the custom
colors so it can be selected.
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5.3.31 When including a PDF image all pages are read

(bug 1797) The typesetting engine incorrectly read all pages from a PDF image when extracting
the dimensions of the PDF page.

5.3.32 Leader fill rendered as literal string &hellip;

(bug 1800) When processing an HTML secondary transform, a leader fill request was rendered as
the literal sting &hellip; in the generated HTML output.

5.3.33 Table row splits at wrong place

(bug 1804) A table cell that declared an image that vertically spanned the content of all other table
cells in the same table row. The typesetting engine applied an incorrect table row spilit.

5.3.34 Frame argument of table-properties has no effect

(bug 1805) The <t abl e- properti es/ > frame attribute sets the implied table frame for a CALS
or HTML table. The value of this attribute was ignored when processing CALS table mappings or
when redefined from a <t abl e> tag mapping.

5.3.35 Horizontal scaling affects vertical position

(bug 1807) The font specification for a style sheet mapping defined a horizontal compression. The
typesetting engine calculated an incorrect vertical position for any line that referenced that font.
5.3.36 Incorrect box and table fill color when output to PDF greyscale

(bug 1809) When creating a PDF using the greyscale color model, the background fill for box and
table cells was output using the current font color, instead of the background fill color.

5.3.37 Letter spacing is not reset at termination of an inline tag

(bug 1820) Letter spacing is now reset correctly when an inline end-tag is processed.

5.3.38 Error assigning jump destination targets

(bug 1821) The typesetting engine generated an error when processing a style sheet that
associated a large number of jump targets and index references with a single line paragraph.
5.3.39 Looseleaf document flagged as not well formed

(bug 1843) A leaf boundary in a looseleaf document was positioned precisely at the end of a tag.
When the end of leaf was processed, the last tag of the leaf was ignored, and the typesetting
engine reported that the document was not well formed.

5.3.40 Incorrect renumbering of looseleaf 999(a) page folios

(bug 1844) A looseleaf publication style requested a 999(a) page folio format. An update
contained 3 adjacent changed leaves, the middle one of which was a stroke page. On
recomposing, the folio number of the stroke page leaf was numbered incorrectly.

5.3.41 Incorrect calculation of table cell indents

(bug 1845) The <cel | - pr operti es/ > command overrides specific table cell styling properties.
Multiple calls to redefine the cell properties for a given cell caused the typesetting engine to
calculate an incorrect set of table cell indents.

5.3.42 Unexpected error when referencing scanned content

(bug 1846) An attempt to reference the content of a scanned tag generated an unexpected error if
the scanned content contained an instance of the same tag.
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5.3.43 Space dropped before a Pl or tag when editing a looseleaf document

(bug 1880) When editing a looseleaf document, a space was inserted between an existing word
and a processing instruction. The inserted space was not saved when the modified content was
saved to the partition.

5.3.44 Auto repeating table header row not cancelled

(bug 1886) When a CALS or HTML table breaks across a page boundary, the table header row is
repeated at the top of each page. The table header failed to cancel when the end of a table was
processed.
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6. 7.5.021

The following chapter outlines the major changes in this release of TopLeaf.

6.1 Date released
2011/03/11

6.2 Enhancements

6.2.1 Tag and custom marker mappings display order

(bug 1728) When applying a style sheet rule, TopLeaf chooses the most appropriate mapping by
applying a set of precedence rules and then selecting the mapping that has the highest
precedence. By default, the Map Manager displays tag and custom marker mappings in
alphabetical order. You can now display tag and custom marker mappings in map precedence
order by setting a GUI general preference.

The content of the map manager dialog has been rearranged to improve the display of long tag or
custom marker context paths.
6.2.2 Upgraded Dashes™ hyphenation module

(bug 1741) The Dashes™ hyphenation module has been upgraded. This will make it possible to
access Dashes™ exception list processing in a future release of TopLeaf.

6.3 Bug Fixes
The following bug fixes were applied in this build.

6.3.1 Abnormal exit if processing instructions contained "' or '>' characters

(bug 1691) A processing instruction contained one or more of the following characters: <>" or"' .
The typesetting engine generated an abnormal exit.

6.3.2 PDF creation fails silently

(bug 1718) An attempt to create a PDF for a page or leaf range failed if the page identifier
contained an illegal filename character.

6.3.3 Problem displaying PDF documents that contained a graphic with zero width and
height

(bug 1726) A TopLeaf style sheet rule resulted in the inclusion of a graphic with zero width & height
in a rendered page. An attempt to display the resulting PDF caused an error in some versions of
Adobe Reader. The typesetting engine now reports an error when an attempt is made to reduce
either image dimension to 0.

6.3.4 Images not rendered when processing a demonstration partition

(bug 1730) The Glossary demonstration partition was typeset and a PDF document was created.
The PDF did not contain any images.

6.3.5 Current font not restored when processing a leaf barrier

(bug 1731) A leaf boundary was declared immediately between an end tag and a start tag. The font
in force immediately after the end tag was not restored.
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6.3.6 PDF builder did not show a progress dialog when called from GUI
(bug 1733) The PDF builder did not show progress dialog when called from the TopLeaf GUI .

6.3.7 Force end of partition at end of file

(bug 1738) In full looseleaf mode, a request to end a leaf or leaf group that is followed
immediately by an end of file is now assumed to be to a request to end the partition.

6.3.8 Importing a TopLeaf format specification

(bug 1739) When creating a new publication, you can import the style sheet rules from another
publication. The imported style sheet file set now includes all associated Perl module files and
publication level graphics found in the source publication folder.

6.3.9 Abnormal exit when testing the value of scanned content

(bug 1740) An element was scanned and the content assigned to a user variable. The length of the
scanned content exceeded 32,000 characters. The typesetting engine generated an abnormal exit
when the user variable was referenced from a conditional test.
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7. 7.5.020

The following chapter outlines the major changes in releases 7.5.018 — 7.5.020 of TopLeaf.

7.1 Date released
2011/02/14

7.2 Enhancements
None.

7.3 Bug Fixes
The following bug fixes were applied in this build.

7.3.1 Water marking PDF documents created by TopLeaf evaluation systems

(bug 1680) The watermark applied to a PDF created using an evaluation copy of TopLeaf is now

shown at an angle, and is an image rather than text.

7.3.2 Improvements to RTF secondary output table processing

(bug 1695) A number of improvements have been applied to the table processor within TopLeaf's
built-in RTF secondary output transform.

7.3.3 Table header rows not identified when generating RTF secondary output

(bug 1696) TopLeaf's built-in RTF secondary output transformation now recognises table header
rows.

7.3.4 Abnormal exit when checking for permitted start of line characters

(bug 1697) After processing an interword space, the typesetting engine applies a line breaking
algorithm to determine if it is possible to start the next word at the beginning of a line. In some
contexts, the typesetting engine generated an abnormal exit when processing CJK content on a
Windows XP system.

7.3.5 colorsin custom box commands not added to RTF color table

(bug 1698) Colors in custom box commands are now added to the RTF color table created by
TopLeaf's built-in RTF secondary output transformation.

7.3.6 Setting the page size in an RTF secondary output

(bug 1700) A transform property has been added to allow setting the RTF page size and margins.

7.3.7 Link targets in tables not created correctly when generating RTF secondary output
(bug 1702) Link targets in tables are now created correctly when generating RTF secondary
output.

7.3.8 Default CFF fonts to no subsetting

(bug 1703) When a CFF font is added to the TopLeaf font configuration file, font subsetting is
disabled by default. If a user enables subsetting for a CFF font, then a warning message will be
displayed when they change the font configuration, and every time they subsequently update it.
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7.3.9 Cannot create level if repository path contains spaces

(bug 1707) An attempt to create a new level within a TopLeaf failed if the TopLeaf repository path
contained spaces.

7.3.10 Composition progress bar goes blank after a large number of pages

(bug 1710) After processing approximately 95% of a 22Mb document file, the composition progress
bar disappeared.

7.3.11 Abnormal exit if margin rule cancelled within an empty table cell

(bug 1714) The composition engine generated an abnormal exit when processing a margin rule
cancellation in a table row that split across a page boundary.

7.3.12 Javaruntime must be 1.5 or later

(bug 1715) The java runtime selection dialog will now only show the installed runtimes of version
1.5 or later. The use of the 1.4.2 java runtime is no longer supported.

7.3.13 Style sheet auto exported files not created

(bug 1721) The <r eadgen/ > command issues a request to automatically generate and read the
contents of a generated file type. It is also possible to export a generated file to a named location by
setting a partition property. An attempt to export a generated file by setting a partition property
failed. The generated file required by the <r eadgen/ > command was not created.

7.3.14 Bind to next does not prevent row splitting

(bug 1722) A style sheet mapping issued a bind to next request within the context of a splittable
table row. When the table row was split, the bind request was ignored.

7.3.15 Typeface not selected when rendering characters from the private use region
(bug 1723) A typeface consisted of a set of glyphs located in the Unicode private use region.
Attempts to render characters from this region were unsuccessful.

7.3.16 Increase limit for scanned content

(bug 1724) Although there is no restriction on the length of content that may be contained within an
element, an individual tag mapping can now scan (capture) and/or suppress a maximum of 1Gb.
An attempt to scan a tag with a content length that exceeds this limit will produce a fatal error.

7.3.17 Wrong value returned by image-info directive

(bug 1725) The <i mage- i nf o/ > command resolves the dimensions of an image using an
optionally defined preferred maximum width or depth. The returned dimensions for an image were
incorrect if the preferred maximum width or depth specified a unit of measure.
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8. 7.5.017

The following chapter outlines the major changes in this release of TopLeaf.

8.1 Date released
2010/12/21

8.2 Enhancements

8.2.1 Improved method for reading generated files

(bug 1339) TopLeaf is capable of creating both tables of contents and indexes from captured
material. Content to any one of nine TOC or Index levels can be automatically written to a separate
table of contents, Index or Xref file, and reintegrated back into the typeset input stream. The

<r eadgen/ > command issues a request to automatically generate and read the contents of a
named file type.

8.2.2 Specifying a context for custom mappings

(bug 1632) Custom mappings now have the same options as ordinary tag mappings; in particular,
you can specify a custom marker context and occurrence.

8.2.3 Listtag and custom marker mappings in map precedence order

(bug 1685) When applying a style sheet rule, TopLeaf chooses the most appropriate mapping by
applying a set of precedence rules and then selecting the mapping that has the highest
precedence. In previous builds, the Map manager displayed tag and custom marker mappings in
alphabetical order. In this build, tag and custom marker mappings are listed in map precedence
order.

8.3 Bug Fixes
The following bug fixes were applied in this build.

8.3.1 Type 1fonts not found on 64 bit systems

(bug 1676) On a 64-bit system installing a Type 1 font only updates the 64-bit registry. If the font
registry key is not found in the 32-bit registry, TopLeaf now searches the 64-bit registry.

8.3.2 Spaces not permitted within PDF profile names

(bug 1681) Itis no longer possible to declare a PDF profile name that contains a space.

8.3.3 RTL demonstrations always included when TopLeaf is installed

(bug 1682) A custom installation was requested when installing TopLeaf. The demonstration folder
was excluded from the installation, but the RTL demonstration publication was installed.

8.3.4 Incorrect font configuration installed with TopLeaf demonstration publications

(bug 1683) A TopLeaf font configuration file copied by the TopLeaf installer listed "Microsoft
Corsiva" as an installed font. This is not present by default on Windows.

8.3.5 Use JAVA_HOME to find java runtime if registry key not defined

(bug 1686) A Java™ runtime is required for various TopLeaf components (PDF builder, Page
Layout, HTML/RTF output and SVG graphics). The TopLeaf API will use the value of the

Page 19



TopLeaf Release Notes

JAVA HOME environment variable to locate the runtime if no runtime has been previously selected
from the TopLeaf GUI.

8.3.6 Incorrect handling of processing instructions

(bug 1689) A processing instruction contained one or more &#x5C; characters. The typesetting
engine failed to render the document.

8.3.7 Image positioned incorrectly when column balancing

(bug 1690) The typesetting engine attempted to column balance the content of a two column
page type that contained a single image. The image was positioned incorrectly.
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9. 7.5.016
This build is a reissue of build 7.5.015.
The following chapter outlines the major changes in this release of TopLeatf.

9.1 Date released
2010/12/06

9.2 Enhancements

9.2.1 Color management

(bug 1639) Colors are specified in style sheet mappings as RGB (Red, Green, Blue) values. These
are used to create device-dependent RGB colors when creating a PDF. You can also create a
color palette for a style sheet. By using a palette, you can see all of the colors used in the style
sheet and assign properties to each one. For example, this allows you to specify CMYK (Cyan,
Magenta, Yellow, Black) values to be used if the PDF profile selected uses the CMYK color space.

9.2.2 Changes to line breaking algorithm

(bug 1669) For European languages that use a Latin character set, TopLeaf regards a word as a
run of characters separated by spaces or punctuation. In the absence of a hyphenation dictionary,
a line break can occur only at explicit word boundaries and where the character at the start of a
word is permitted at the start of a line. By default, the following punctuation characters are not
permitted at the start of a line unless immediately followed by a Latin letter character or number:

' %) , . ;21 %} 7 ° . »
Additional language specific line breaking rules are automatically applied when processing
Chinese, Japanese, Korean and Arabic content.

The Map Manager <t ext - pr oper ti es/ > directive can be used to control the behaviour of the
line breaking algorithm.

9.3 Bug Fixes
The following bug fixes were applied in this build.

9.3.1 Style sheet definitions in partition properties file declared using absolute file paths

(bug 1559) The document association with a linked partition was changed. The style sheet
definitions in the partition properties file were declared using absolute file paths.

9.3.2 ToplLeaf typesetting engine hangs if called from a service or a batch script

(bug 1655) If a serious error occurs when typesetting a document, Windows may display an error
mode dialog. If the TopLeaf API is used to compose a document from a Windows service or a batch
script, this may cause the calling application to hang if Windows displays an error mode dialog.

9.3.3 Release label does not revert when you cancel an update

(bug 1660) When creating the next update for a partition, TopLeaf automatically assigns the
release number as the default release label (for example, in release 16, the default release label
would be 016). A user defined release label was assigned to an update. The update was cancelled,
and then recreated. The user defined release label was retained.
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9.3.4 Unable to declare an empty word break set

(bug 1667) The <t ext - properti es break- char s="BC"'/ > directive declares a set of word
break characters that remain active for the scope of the current element. An attempt to declare an
empty word break list was ignored.

9.3.5 No error code returned when generating an undefined secondary transform

(bug 1668) The TopLeaf API GETTRN command retrieves a transformed version (for example,
RTF or HTML) of the data in a partition. An attempt to retrieve and undefined transform type now
returns an error.

9.3.6 Incorrect left margin when rendering page footnote

(bug 1670) When calculating the left margin a page footnote, the typesetting engine applied the left
indent for the $not e system mapping. The rendered position of the page footnote was incorrect.
9.3.7 Unexpected spaces inserted by preserved space mode

(bug 1671) In some circumstances, the typesetting engine inserted additional spaces when
processing content in preserve space mode.

9.3.8 Inherited font leading overrides leading declared within mapping

(bug 1672) A tag mapping declared a mapping specific font leading. The tag mapping then
referenced a custom marker mapping that declared a different font leading. The inherited font
leading was applied and the leading declared by the custom marker mapping was ignored.

9.3.9 Running head not cancelled before page change

(bug 1677) A request to cancel a running head was issued immediately before a request to force a
page type change. The running head was not cancelled.
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10. 7.5.014

The following chapter outlines the major changes in this release of TopLeaf.

10.1 Date released
2010/11/08

10.2 Enhancements

10.2.1 Dropped labels

(bug 1613) A label is a semi-independent fragment at the start of a paragraph. A common example
is the bullet, number or letter at the start of a list item, but numbered headings also often have the
number set as a label. A dropped label is a special form of label inserted at the beginning of a
paragraph, with sufficient lines indented to leave room for the 'dropped' material. Dropped labels
can be used to create a "dropped cap" effect at the start of a paragraph.

10.2.2 Float splitting

(bug 1638) A TopLeaf float is a typesetting object containing paragraphs, graphics, table rows or
boxes. A float is positioned at the bottom or top of a subsequent column or page by floating' it
forward through the surrounding content in which it is declared.

If the depth of a column float exceeds the column height, TopLeaf will attempt to split the float. The
split float will then continue over as many columns as needed to hold the material, after which the
normal text will resume. TopLeaf will generate a non-fatal error if the depth of a column float
exceeds the column height and the float cannot be spilit.

10.3 Bug Fixes
The following bug fixes were applied in this build.

10.3.1 HTML table spanned cell widths

(bug 1640) The table cell widths calculated for a HTML table header and table body did not align
correctly, even though the widths were identical.

10.3.2 Page footnote margins

(bug 1641) A page footnote was declared in the context of a right page data block. If the footnote
was rendered on the following page, the page footnote was positioned using the right page block
margins.

10.3.3 Set RGB blending when applying a watermark

(bug 1645) When a transparent watermark is applied, the blending color space is now set to RGB.
This prevents some color changes due to conversions in the default blending space.

10.3.4 Hyphen in data not used as break point if hyphenation disabled

(bug 1646) If a hyphen character was declared as a word break character, the typesetting engine
processed it as an emergency word break, and not a preferred word break. All characters declared
as word break characters are now processed as preferred word breaks.
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10.3.5 Deleting mapping sets typeface for following mapping

(bug 1647) A mapping was deleted after viewing the current font settings in the Map Manager Font
tab., The typeface details for the following mapping were updated.

10.3.6 Leaf split verification error when processing comment

(bug 1650) A loose-leaf document declared an XML comment that contained an apostrophe. A leaf
split verification error was generated when publishing the partition.

10.3.7 Graphic referenced by image mapping processed in incorrect context

(bug 1658) A tag mapping requested the inclusion of an image. The pre-content customisation
for the mapping called a custom marker block mapping. The end tag processing for the custom
marker was deferred until after the image was processed. The image was processed in the context
of the custom marker mapping, and was rendered incorrectly.
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11. 7.5.013
This build is a reissue of build 7.5.012.
The following chapter outlines the major changes in this release of TopLeatf.

11.1 Date released
2010/10/08

11.2 Enhancements
None.

11.3 Bug Fixes
The following bug fixes were applied in this build.

11.3.1 Usetable-properties style overrides

(bug 1604) Some additional styles defined by the <t abl e- pr operti es/ > directive are now
honored when generating secondary output transformations.

11.3.2 Characters missing from PDF output

(bug 1620) When using a CFF font with a Unicode encoding some characters did not appear in the
PDF. Now using version 2.1.7 of the iText library.

11.3.3 Incorrect white space processing within scanned content

(bug 1622) A mapping scanned the content of a tag and associated that content with the
<cont ent / > directive. One or more significant white spaces were removed from the scanned
content if it contained an XML comment.

11.3.4 Processing of empty elements

(bug 1623) An element with no content is said to be empty. The representation of an empty
element is either a start-tag immediately followed by an end-tag, or an empty-element tag. All
empty element tags are always processed as if they were declared as a start-tag immediately
followed by an end-tag.

11.3.5 Hyphenation rules ignore non-breaking spaces
(bug 1624) The typesetting engine generated an incorrect hyphenation point when processing two
words that were separated by an unbreakable space.

11.3.6 Error scanning a nested tag

(bug 1625) A mapping scanned the content of a tag and associated that content with the

<cont ent / > directive. The tag content was assigned to a page footnote. The page footnote
contained an embedded instance of the parent tag, and the embedded tag was also scanned. The
scanned value of the parent tag was lost.

11.3.7 Incorrect processing of CALS table vertical span

(bug 1626) The nor er ows attribute of a CALS table ent r y declared a vertical span. The
specified number of rows in the vertical span exceeded the number of remaining rows in the table.
The typesetting engine generated an ambiguous error message that implied the table was not well
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formed. An error is reported if any morerows vertical straddling extends beyond the rows
appropriate to a <t head>, <t f oot >, or <t body>.

11.3.8 Breakable box state not saved when processing nested unbreakable box

(bug 1627) An unbreakable box was nested within the context of a breakable box. The breakable
box state was not restored when the unbreakable box was closed. A subsequent attempt to end the
unbreakable box was ignored.

11.3.9 Error accessing English language hyphenation dictionary

(bug 1630) The standard TopLeaf license supports English language hyphenation. Multi-
language hyphenation support is enabled by purchasing a separately licensed Dashes™
hyphenation module. The English language dictionary referenced by a standard TopLeaf licence
was found to be corrupted. As a consequence, many words in that dictionary could never be
hyphenated.

11.3.10 Widow/Orphan state ignored

(bug 1634) The $docunent mapping declared the Widow/Orphan state as None. Subsequent
mappings attempted to redefined the Widow/Orphan state. The attempts were ignored.

11.3.11 Abnormal exit when processing data telltales
(bug 1635) A null pointer was referenced when running a scan for active telltales.

11.3.12 Problem with entrytbl when row splitting enabled

(bug 1636) When table split-rows mode is enabled, a break across a column or page boundary
may also occur within a table row. If a table row contained an ent r yt bl element, table split rows
mode was unexpectedly disabled.

11.3.13 Double sided page types regarded as multi-column layouts

(bug 1637) When switching from a single column layout to a double sided single column layout, the
typesetting engine incorrectly processed the double sided layout as a two column layout.
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12. 7.5.011

The following chapter outlines the major changes in this release of TopLeaf.

12.1 Date released
2010/09/20

12.2 Enhancements
The following enhancements were applied in this build.

12.2.1 Float support in secondary transformations

(bug 1576) TopLeaf's secondary output transformations now process float objects. The RTF
and HTML output handlers emit any floats that have been encountered at the end of each file
created. Unlike end notes, there is no automatically generated link from the point where the float is
referenced; if this is required it must be created the same way as other links.

12.2.2 Use typeface selection scheme in secondary transforms

(bug 1579) The secondary output transformation handlers now search for a typeface selection
scheme and try to match the typeface referenced within a mapping with a scheme name. If found,
the typeface name(s) are used in the output. For HTML secondary transforms, all of the typeface
names are used in the CSS style. For RTF transform, only the first typeface name is used.

12.2.3 Set default transform properties from metadata

(bug 1587) Itis now possible to use metadata variables to set default values for secondary
transformation properties. The default is only used if no explicit value is set for the property when
the transformation is performed.

12.2.4 Page segment properties

(bug 1593) Each part of the page formatted with a particular pagetype is called a segment, and the
page is called a multi-segment page. The <segnent - pr operti es/ > command control aspects
of TopLeaf's segment styling rules. Facilities exist to apply a segment box style or select page or
column running heads.

12.2.5 Font letter spacing

(bug 1594) You can use font letter spacing to increase or decrease the amount of additional white
space between letters. The letter spacing width is expressed as a percentage of the current font
size. For example, a setting of 10% will (for a 20pt font) set an letter space of 2pt (10% of 20pt), a
setting of -3% will apply a letter space of -0.6pt.

12.2.6 HTML internal table rules

(bug 1607) The <t abl e- pr operti es/ > directive allows you to override or declare specific
HTML or CALS table styling properties. The rules attribute sets the implied internal table rule state
for an HTML table. This value will only be used if the table or DTD specification contains no other
indication of the implied table frame.

12.2.7 Header & Footer properties

(bug 1610) By default, TopLeaf aligns the content of a fixed block at the top of the fixed block
region. If the vertical depth of the content of a fixed block is smaller than the fixed block depth, then
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you can use the <headf oot - pr operti es/ > directive to specify a preferred vertical alignment for
the content in the block.

12.2.8 Embed RTF images as PNG or JPEG

(bug 1611) The interpretation of the i ngenbed property for RTF secondary transformations has
changed. The defaultis now t r ue. This will embed the image using PNG or JPEG format if
possible, or WMF if not. The value wnf value can be used to force WMF to be used. To preserve
the former behaviour, seti ngenbed=""f al se" for any API calls that do not set this property.

12.3 Bug Fixes
The following bug fixes were applied in this build.

12.3.1 Export of live pages fails without reporting error

(bug 1199) The format of the filing instructions generated for an initial change pages release
was different to that generated for an update. Any errors that occur when generating this file are
now reported with a more specific reason for the failure.

12.3.2 Error processing UTF-8 characters declared within entity declarations

(bug 1553) The typesetting engine failed to process an XML entity declaration that contained a
UTF-8 multi-byte character sequence.

12.3.3 Incorrect column balancing when processing tables and running heads

(bug 1588, 1589) The typesetting engine column balancing algorithm now accounts for
unbreakable regions generated by table headers and running heads.

12.3.4 Unresolved entities in PDF bookmarks

(bug 1590) The typesetting engine failed to resolve CDATA entity references declared in the
context of a PDF bookmark.

12.3.5 CJK word breaking rules not honored

(bug 1591) The typesetting engine did not correctly track the preferred word breaking rules when
processing CJK content.

12.3.6 Paragraph overrides affected all mapping instances

(bug 1592) A mapping declared a paragraph override via a user variable. When generating the
output for a secondary transform, the change was applied to the mapping itself, so it affected
instances of the mapping with no override.

12.3.7 Incorrect processing of word break characters

(bug 1595) If an &anp; was declared as a word break character, the typesetting engine flagged a
preferred word break at the start of every entity reference. When a preferred word break character
was followed by a interword space, the interword space was discarded.

12.3.8 Baseline shiftignored when generating HTML output

(bug 1597) The HTML secondary output transformation now applies the baseline shift using the
vertical-align CSS property, unless this property is already used to specify subscript or superscript.
12.3.9 Firstline indent honored when generating HTML output

(bug 1598) The HTML secondary output transformation now honors the first line indent of a block.
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12.3.10 Firstlineindentignored when generating HTML output

(bug 1600) When generating a secondary output transformation, content emitted in the post-
content of a table mapping was included in the last table cell instead of being placed after the table.
12.3.11 Unexpected content change when updating a loose-leaf document

(bug 1605) A change to a loose-leaf document included a fullstop character embedded within white
space. When the document was applied to the current update, the input differencing algorithm
misinterpreted the fullstop character as a differencing directive, creating an unexpected change in
the stored content.

12.3.12 Baseline shift ignored if font color selected

(bug 1606) A mapping requested a baseline shift. If the mapping also set a font color via the
<f ont - pr operti es/ > directive, the baseline shift was not applied.

12.3.13 No error reported when declaring a sidenote within a float

(bug 1608) An attempt to define any note type (for example, a. running head, telltale, footnote,
sidenote, or float) within the context of any other note type (running head, telltale, footnote,
sidenote, or float) is now ignored, and generates a non-fatal warning.

12.3.14 Ability to declare a PDF crop box missing from distributed PDF builder

(bug 1615) Builds of TopLeaf 7.5.005 and later did not include the changes for setting the crop box
in the PDF.

12.3.15 Widow / Orphan property redefined when processing fixed block content

(bug 1618) The typesetting engine unexpectedly redeclared the widow / orphan lines property
when switching between data block and fixed block content.
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